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STRUCTURE 

UNIQUE SLIDE TITLE 

Unlike Microsoft Word, PowerPoint does not support heading structure, instead PowerPoint 
has a unique slide title that acts as headings which inform the reader what the slide is about. 

Slide titles are used for navigation and selection by people who are not able to view the slide. 
Ensure that each slide has a unique title by using the pre-made template in PPT to create 
slides. Select the option from the New Slide.  

 

If you are on a blank slide, select to add a pre-made template by choosing the option from 
Layout menu.  
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Contents added in each slide can be view using the Outline View in PowerPoint. 

To check for the outline of the document: 

1. Navigate to the View tab. 

2. Select Outline View. The outline panel will be displayed on the left-hand side. The title 
for each slide should be reflected on the physical view. 
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SLIDE MASTER 

Slide master provide a uniform and structured layout for your PowerPoint slides. Slide master 
allows to add common elements that will be repeated throughout all the slides such as fonts, 
footers, and logos. In terms of accessibility, slide master has a built-in feature to format the 
document with slide title and correct hierarchical structure for body content.  

Navigate to the View tab to generate Slide Master.  
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Note: It is recommended to create Slide Master before you start to create new individual slides 
as it adds as options for slide layout. To learn more about slide master, see Microsoft Support: 
What is a slide master?  

READING ORDER 

In designing your PowerPoint, ensure that the reading order of each slide is logical. People who 
cannot view the slide will hear slide text, shapes and content read in a specific order using a 
screen reader. If you are using objects that are not part of the slide template, it is important to 
be sure that they will be read by a screen reader in the order that you intend them to be. 

CHECK FOR READING ORDER 

Reading order pane can be checked by using the Check Accessibility feature.  

1. Navigate to the Review ribbon. 

2. Select Check Accessibility. 

https://support.microsoft.com/en-us/office/what-is-a-slide-master-b9abb2a0-7aef-4257-a14e-4329c904da54
https://support.microsoft.com/en-us/office/what-is-a-slide-master-b9abb2a0-7aef-4257-a14e-4329c904da54
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3. Choose Reading Order Pane.  

 

4. From the Reading Order pane that appears on the right-hand side, check for logical 
reading order of each element on the slide. 

 

LIST 

Lists are used to format information sequentially without the use of characters such as plus 
signs or asterisks. Always use Bullets or Numbering tools instead of other characters for listing 
information.  
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BULLETED LIST VS NUMBERED LIST: 

• Use numbered list for items that specify order. 
 Examples: timeline or set of instructions  

• Use bulleted list where order is not important. 
 Example: grocery or recipe list. 

Note: Lists can be mixed such as using a bulleted list inside a numbered list, or vice versa.  

HOW TO CREATE A LIST IN POWERPOINT: 

1. Highlight the text you wish to format. 

2. Navigate to the Home tab. 

3. Select the Bullets or Numbering tool drop-down list options. 

4. Select the desired bullet style. 

 

TWO-COLUMN LISTS 

When a list is too long for a single text box, avoid using two separate text boxes to span 2 
column lists. This method is a common mistake that breaks up the list into 2 different lists 
instead of one. 

Best Practice: use two or more columns lists to break up a long list that cannot be fitted into a 
single text box. 
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To add columns to text boxes: 

1. Select the desired list. 

2. Navigate to the Home tab. 

3. In the Paragraph pane, select the Columns drop-down to choose from one of the 
options. 
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ALTERNATIVE TEXT AND IMAGES 

Alternative text also known as “alt text” is a brief 8 to 120-character description describing the 
elements of the image or what the image is conveying. Screen readers rely on alternative text 
to describe the image to the reader. In situations where the image is not available to the 
reader, perhaps because they have turned off images in their web browser or are using a 
screen reader due to a visual impairment, the alternative text ensures that no information or 
functionality is lost. The content creator is the best person to determine the alternative text for 
an image. Context is important when determining the alternative text; it will let you know if the 
alternative text is too descriptive or not descriptive enough. 

Note: Alternative Text can also be applied to Clip Art, Charts, Tables, Shapes*, SmartArt 
graphics, Groups**, Embedded objects, videos, and audio files. 

*Clip Art, Charts, Tables, and Shapes that do not contain text and are not in groups can have 
Alternative Text applied to them. 

**All objects in this list, except for shapes, should also have alt text when in groups. 

MEANINGFUL IMAGES 

Meaningful images provide essential information and is required to have alternative text. 

HOW TO ADD ALTERNATIVE TEXT: 

1. Select the desired object. 

2. Right click and select View Alt Text from the context menu. Alternatively, you can 
navigate to the Picture Format ribbon and select Alt Text option. 
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3. Type a brief but descriptive Alt Text for the graphic in the box provided. Click on the 

close button once done. 
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DECORATIVE IMAGES 

Decorative images are images that present no important content to the context of your 
document. They are purely aesthetic. If you have images in your document that serve visual 
purposes and do not provide any information (clip art, banners, background images, etc.), mark 
them as decorative. 

HOW TO MARK IMAGES AS DECORATIVE: 

1. Select the desired object. 

2. Right click and select View Alt Text from the context menu.  

3. Select the “Mark as decorative” checkbox. 

 

IMAGES OF TEXT 

Images of text display text as an image. It is highly recommended using actual text rather than 
image of text. Actual text is much more flexible in comparison to images of text that it can be 
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resized without losing clarity and enable users to customize things like color and contrast based 
on user’s preferences. Image of text is best use as logo when the visual presentation is 
essential. 

Alternative text for images of text should reflect the text within the image. If the image contains 
more than 120 characters, consider including the text elsewhere within the document. 

  

COMPLEX IMAGES 

Complex images are images that convey substantial information and require over a 120- 
character description, such as graphs and charts. Figure captions can be used in addition to alt 
text and are placed above or below the image. Contrary to alt text, there is no character limit 
for figure captions.  

Unlike Microsoft Word, PowerPoint does not have a figure caption function. To manually add a 
figure caption, use a textbox or content placeholder.  

Note: An image that has a figure caption also needs to include alternative text since alternative 
text is required for all images. Ensure that alternative text does not repeat exactly what is 
already stated in the figure caption. 

Tip: Alternative text for complex images can briefly describe the image and reference to read 
more in the figure caption. If the description of the figure caption is too long, provide an 
external link to the source for reference. 
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ALTERNATIVE TEXT AND IMAGES BEST PRACTICES 

• Avoid using phrases such as “image of” or “photo of” for alt text because screen reader 
will repeat this information. 

• Avoid using images of text due to low image quality when resized. 
• The “Alt Text” tool does not have spell check, please ensure that the alt text is spelled 

correctly. 
• Avoid using the “generate a description for me” feature because the alternative text 

may not always be accurate. 
• Decorative images that do not convey any meaning do not require alternative text and 

should be marked as decorative. 
• If the alternative text is too long, consider using figure captions by adding textbox below 

the image to provide descriptive information. 
• If the type of image is important such as water painting or pencil drawing, include it in 

the alt text. 
• Avoid using screenshots or images of lists, tables, or similar contents as alt text can be 

very long and content structure is not available for screen reader users. 
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FONTS 

Use simple and accessible fonts when formatting a Word document. Highly recommend using 
built-in fonts within Microsoft Word as it can be access across platforms and operating systems. 

ACCESSIBLE FONTS 

Use Sans-Serif fonts such as Arial, Calibri, Verdana, Tahoma, Helvetica, etc.  

 

Note: avoid using various types of fonts and overly decorative fonts within the same document 
as it can affect individuals with cognitive disability.  

For more information on accessible fonts, see Google's Introducing accessibility in typography. 

FONT SIZE 

Font size is extremely important for users with visual impairment. Ensure that the font size for 
each slide is 18 points or larger.  

https://fonts.google.com/knowledge/readability_and_accessibility/introducing_accessibility_in_typography
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LINKS 

Link text should provide a clear description of the link destination, rather than only providing 
the URL. There are many options when it comes to including a hyperlink in your document. You 
can insert and attach a hyperlink with an email, an external document, webpage, or even within 
the same document. 

Links must have a descriptive link text that describes the intent or purpose of the link. For 
example, avoid using “Click here” or “Read more.” Assistive technology users often navigate 
through links to skim through the document, when they come across links descriptions like 
“Click here,” they will not understand the purpose or the link’s destination. Instead, include the 
webpage or document title as the link description. In addition, long URL addresses can be 
cumbersome for assistive technology users to listen to. 

LINKS: DO’S AND DON’TS 

Do’s:  

• Use descriptive link text that describes the intention of the link. 
• Good examples: 

 CSULB Accessible Instructional Materials (AIM) Center 
 W3C Accessibility Standards Overview 

Don’ts: 

• Avoid using ambiguous link text or URL addresses. 
• Bad examples: 

 Click here or Read more 
 https://www.w3.org/WAI/standards-guidelines/ 

APPEARANCE OF LINKS 

Links must be visually different from regular text. Links are often identified by using underline 
and color. However, color shouldn’t be the only method to identify links and should be 
accompanied by an underline or italics. Both these methods will help increase the document’s 
readability by allowing the reader to identify links visually. 

https://www.csulb.edu/student-affairs/accessible-instructional-materials-center
https://www.w3.org/WAI/standards-guidelines/
http://www.google.com/
https://www.w3.org/WAI/standards-guidelines/
https://www.w3.org/WAI/standards-guidelines/
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Figure 1 In the example above, there are no visual indicators for links such as underline and 
color. Readers will not know that links are present within the paragraph. 

 

Figure 2 In the example above, the links appear visually different from regular text. The link text 
contains a combination of color and underline. The combination of these indicators will make 
the links apparent to visual readers. 

HOW TO INSERT A LINK IN POWERPOINT:  

1. Highlight the desired text. 

2. Right click and select Link from the context menu. Alternatively, navigate to the Insert 
tab and select Link. 

 

3. In the Insert Hyperlink window, select Existing File or Web Page (external link), check 
for the correct URL Address, and ensure that Text to display is descriptive and human 
readable.  
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SPECIAL CASES 

LINKING PHONE NUMBERS AND EMAIL ADDRESSES: 

It is highly recommended to use both descriptive link text followed by actual email or phone 
number, allowing users to save this information for future reference.  

Example of email address: AIM Center (aimc@csulb.edu) 

Example of phone number: BMAC Main Office (562-985-5401) 

LINKS ON PRINT DOCUMENTS: 

If the document is available digitally and as physical copy, it is preferred to include a descriptive 
link text followed by the full URL address of the link. 

Example: CSULB College of Business [https://www.csulb.edu/college-of-business] 

LINKS FOR FILE DOCUMENT TO DOWNLOAD: 

If the link is direct to open or download a document such as PDF, include the title of the 
document as the link text followed by the file type. 

Example: 2022-2023 CSULB Academic Calendar (PDF) 

mailto:aimc@csulb.edu
tel:562-985-5401
https://www.csulb.edu/college-of-business
https://www.csulb.edu/college-of-business
https://www.csulb.edu/sites/default/files/document/academic_calendar_22-23_text.pdf
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COLOR CONTRAST 

Color is often used to make documents visually appealing and attract the reader’s attention. 
Color contrast has to do with the relationship between colors and their perceived visibility. In 
the context of accessibility, it is advised that the content creator use high contrast color 
combinations to avoid any potential issues with reading/visibility. 

Color contrast should meet the minimum Level AA standard and maintain at least a color 
contrast ratio of 4.5:1. There are different accessibility software and programs, such as the 
WebAim Contrast Checker, to check for color accessibility. 

For example, black print on white paper or white print on black paper are high contrast color 
combinations. Students who are color blind can potentially have issues with low contrast color 
combinations.  

COLOR TO CONVEY INFORMATION 

Color should not be the only method to convey information. Readers that cannot perceive color 
will be unable to understand the context or representation of the color. Instead, in combination 
with color, use different objects such as shapes to differentiate between content. 

EXAMPLE OF COLOR INFORMATION:  

 

Figure 3 The image on the left shows the color version to demonstrate how readers perceive 
color will view the image. They will be able to find the number of orange triangles. The image 
on the right shows how people cannot perceive color will view the image. They will be unable 
to find the number of orange triangle as they all appear the same. 

https://webaim.org/resources/contrastchecker/
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Figure 4 This image asks, "how many triangles are there?" This question does not rely on 
sensory characteristics such as color to understand the context of the question. 

COLOR CONTRAST BEST PRACTICES 

• Avoid using light orange, red, and green in your template and text. 

• Use texture or label in graphs, instead of color, to highlight points of interest. 

• Circle to highlight information, rather than relying on color. 

• Keep the overall contrast in your presentation high. In other words, avoid using light 
colored text against light backgrounds, and dark colored text against dark backgrounds. 

• Colour Contrast Analyser is a free software that checks contrast accessibility for 
background and foreground colors using WCAG 2.1 standards. 

• Color Safe develops accessible color palettes. 

 

  

https://developer.paciellogroup.com/resources/contrastanalyser/
http://colorsafe.co/
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TABLES 

DATA TABLE 

Data tables are used to present data information in a grid or tabular format. Data tables must 
have column headers to be accessible. 

 

LAYOUT TABLE 

Layout tables do not present any associations between the cells and are not format with 
columns headers, they are typically used to organize visual information. Avoid using layout 
tables as they are inaccessible and do not provide meaningful order of the content. 

 

Figure 5 Visual users will read the table as “Push The Button To Activate”, however, if not 
linearized properly, the screen reader will read it as “Push Activate The To Button.” In many 
cases, the linearized reading order and visual reading order may not be the same, thus, making 
it difficult for screen reader users to understand the contents within layout table. 
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HOW TO CREATE ACCESSIBLE TABLES: 

1. Navigate to the Insert tab. 
2. Select the Table functionality. 
3. Choose the number of rows and columns for your table. 

 
4. After the table is created, ensure that the Header Row check box is checked. 

 

TABLES BEST PRACTICES 

• Have clear and understandable column or row headers (week, due date, grades, 
topic, etc.) 

• Use data table to present tabular information. 
• Use simple table with single header. 
• Avoid merging cells. 
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• Avoid merging multiple tables together. 
• Avoid layout tables. 
• Avoid low contrast cell colors. 
• If a table has an empty cell, indicate that there is no data such as N/A or Not Applicable. 
• Ensure that the table borders are visible. 
• Avoid adding table title (known as a caption) in a table cell. Caption should be placed 

before or after the table. 
• Avoid using vertical text as it is can be difficult to read. 
• Avoid creating long tables that span more than one page. 

To read more about accessible tables, see CSUN Web Accessibility Criteria: Tables. 
 
 

  

https://www.csun.edu/universal-design-center/web-accessibility-criteria-tables
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VIDEOS AND AUDIOS 

If your PowerPoint slide contains videos and audios. Ensure that the embedded videos have 
synchronized captions and avoid having flashing contents. 

The best way to add videos to PowerPoint slides is to include links of the videos to external sites 
such as YouTube.  

Refer to Microsoft Support: Add closed captions or subtitles to media in PowerPoint for more 
information. 

ACCESSIBILITY CHECKER 
Just as the spelling checker tells you about possible spelling errors, Accessibility Checker in 
PowerPoint tells you about possible accessibility issues in your document file, so you can fix 
these issues to ensure someone with a disability can read and access your content. 

Please note that the Accessibility Checker does not ensure 100% accessibility. However, it is a 
great tool for reviewing your document for errors you could possibly have missed. 

Follow these steps to utilize the Accessibility Checker: 

1. Navigate to the Review tab. 

2. Select Check Accessibility. Alternatively, you can locate the Accessibility Checker on the 
bottom left of the document, next to the slide number.  

 
3. The Accessibility Inspection pane will pull up on the right-hand side. 

https://support.microsoft.com/en-us/office/add-closed-captions-or-subtitles-to-media-in-powerpoint-df091537-fb22-4507-898f-2358ddc0df18#OfficeVersion=Newer_versions
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4. Follow the checker and make the proposed changes to ensure accessibility of your 
document. 
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SAVING POWERPOINT SLIDES INTO ACCESSIBLE 
PDF 

The most accessible conversion from Microsoft PowerPoint into PDF is using the PDFMaker 
plugin or Save as Adobe (PDF). To ensure that Microsoft PowerPoint is converting into 
accessible PDF: 

1. Navigate to the Acrobat Tab.  
2. Select Preferences. 
3. From the Acrobat PDFMaker menu pop-up, check box “Enable Accessibility and Reflow 

with tagged Adobe PDF.”  
4. Hit Ok to save preference settings.  
5. After you have set the preferences, select Create PDF in the same tab, and save the file 

to your local computer. 
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Note: Avoid saving documents using Print to PDF as the it removes the tag structure, making 
the document inaccessible. 

If you do not have Acrobat Plugin in Microsoft PowerPoint, save the document as PDF on your 
local computer by: 

1. Navigate to the File menu. 
2. Select Save As. 
3. Save the document as PDF. 
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4. Select the Options… menu. 

 
5. In the Options window, ensure that Document structure tags for accessibility is checked 

and press OK to save the document. 
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ACCESSIBILITY LAWS 

SECTION 504 AND THE AMERICANS WITH DISABILITIES ACT OF 
1990 

Section 504 of the Rehabilitation Act of 1973 created and extended civil rights to people with 
disabilities. Section 504 has provided opportunities for children and adults with disabilities in 
education, employment, and various other settings. It allows for reasonable accommodations 
such as special study areas and assistance as necessary for each student in Federal agencies. 
Section 504 laws were then extended through the Americans with Disabilities Act of 1990 and 
the ADA Amendments Act of 2008 (ADAAA) which broadened the definition of “disability” to 
cover both individuals with physical and mental disabilities. 

SECTION 508 

This amendment to Section 504 and the Americans with Disabilities Act of 1990 was enacted in 
1998 to eliminate barriers in information technology, to make available new opportunities for 
people with disabilities, and to encourage development of technologies that will help achieve 
these goals. The law applies to all Federal agencies when they develop, procure, maintain, or 
use electronic and information technology. Under Section 508, agencies must give employees 
and members of the public with disabilities access to information that is comparable to the 
access available to others. California Government Code Section 11135-11139.8 requires all 
agencies that receive state money to comply with Section 508, and Executive Order Number 
926 requires all CSU campuses to comply with Section 508. 

ACCESSIBLE TECHNOLOGY INITIATIVE (ATI) 

Effective on January 1st, 2005, Chancellor Charles B. Reed enacted CSU Executive Order 926, 
“The CSU Board of Trustees Policy on Disability Support and 

Accommodations.” The intent of the Accessible Technology Initiative is to make information 
technology resources and services accessible to all students, employees, and guests regardless 
of disability. CSULB is committed to the implementation of this initiative by maintaining 
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consistent accessibility and promoting assistive technology to students, administrators, and 
faculty campus wide. 

THIS ISN’T JUST THE LAW: 

This is your chance to assist this longstanding and respected institution of learning to better 
serve the public with only the greatest intentions of educational and moral outcomes for the 
success of others. 
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RECAP AND FURTHER RECOMMENDATIONS 

• Remember that accessibility is more than just obeying laws; it’s your 
moral responsibility. 

• Assign a document title and set the language to your documents. 

• Assign alternative text to your images and tables. If an image is purely decorative, mark 
it as decorative. 

• Always use the “Bullets” or “Numbering” tools to make lists. 

• Use Columns tool to split the lists. 

• Use single language and font style. 

• Use simple table structures. 

• Avoid long table, especially that span more than one page. 

• Avoid using blank cells in tables. 

• Label hyperlinks with simple, but accurate descriptions. 

• Avoid using low contrast colors (pale or gray colors against white paper). 
• Try and keep your font size at least 12 points or larger. Ensure font size is 

sufficient. If your presentation will be viewed on a projector, font size may 
need to be even larger. 

• Label slides with unique titles. 

• Make sure the reading order flows properly. 

• Avoid using repeated blank [spacebar or return] characters (they will 
read as “blank” repeatedly by screen readers). 

• Avoid image watermarks (they may not be understood by people with 
visual or cognitive disabilities). 

• Use simple slide transitions when possible. Complex transitions can be 
confusing or distracting. 

• Ensure that embedded video and audio contains captioning.  
• Run the accessibility checker to make sure you have made all 

appropriate changes to ensure accessibility is met.  
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RESOURCES 

• ASU IT Accessible PowerPoints 

• Dos and Don’ts on Designing for Accessibility 

• Harvard University: Designing for Readability 

• Microsoft: Make Your PowerPoint Accessible to People with Disabilities 

• WebAim: Alternative Text 

• WebAim: Links and Hypertext 

• WebAIM: PowerPoint Accessibility 

• CSULB: Document Accessibility 

• AIM Center: Accessibility Resources 

• AIM Center: Microsoft PowerPoint Training Videos 

• Creating Accessible PowerPoint Presentations (YouTube video) 

• Americans with Disabilities Act Government Homepage 

• Section 504 Government Homepage 

• Section 508 Government Homepage 

• EO-926 / Accessible Technology Initiative Statement 

https://accessibility.asu.edu/articles/powerpoint
https://accessibility.blog.gov.uk/2016/09/02/dos-and-donts-on-designing-for-accessibility/
https://accessibility.huit.harvard.edu/design-readability
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25?ui=en-us&rs=en-us&ad=us
https://webaim.org/techniques/alttext/
https://webaim.org/techniques/hypertext/
https://webaim.org/techniques/powerpoint/
https://www.csulb.edu/information-technology/accessible-technology/document-accessibility
https://www.csulb.edu/student-affairs/accessible-instructional-materials-center/accessibility-resources
https://www.youtube.com/playlist?list=PLELSqs1L9DEAtJ5ZgC_PurK9CMjbjK6qu
https://www.youtube.com/watch?v=yk0pvTeX5XA
https://www.ada.gov/
https://www2.ed.gov/about/offices/list/ocr/504faq.html
https://www.section508.gov/
https://www.calstate.edu/eo/EO-926.pdf
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